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This manual explains how to install, configure, and use WinSPIRS 5.0.

Using this Manual

This Manual is available in PDF format so you can view it in Adobe 
Acrobat Reader. You can print the document, or use it online. If you use 
it online you can click on a Table of Contents entry, or a cross-reference, 
to move to the relevant text.

Some Conventions used in this Manual

These are the conventions used throughout this manual

Example Describes

/sproot/bin This bold type indicates a filename, or a directory 
path, or a URL.

pkgadd This typeface indicates text as you would type it, or 
an example of how it appears on the screen.

filename This bold type indicates a placeholder, when in-
cluded in something you type. You substitute the 
text appropriate to your system. 

filename This italic type indicates a placeholder, when de-
scribed in the text. 
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root This italic type indicates an account name.

File This bold type indicates a menu, menu option, or 
the name of a button on the screen.

It is also used for command names.

[Enter] This bold type inside [ and ] indicates a key on your 
keyboard. Note: if the instructions say “Enter...” 
this means type in the text as instructed, (substitut-
ing your text for any placeholders) and press the 
[Enter] key.

Example Describes
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Databases are organized collections of records. Each record represents an 
article, book, bibliographic citation, etc. Records are divided into 
categories of information known as “fields,” such as title, author, etc.

WinSPIRS lets you search databases and display, print, or save the 
retrieved records. You can also save your search strategy to use again in 
later sessions.

Before You Begin Before you begin working with WinSPIRS, you should be familiar with 
general Windows techniques, such as how to move and resize windows 
and how to use the mouse. If you have any Windows-related questions, 
see your Windows documentation. All references to mouse clicks refer 
to the left mouse button on a right-hand mouse unless otherwise 
specified.

What is in this 
Manual?

Listed below are brief descriptions of the contents of this manual.

Read... If you are... It will tell you...

Chapter 2 Responsible for 
installing WinSPIRS

How to get the 
software, and install 
and configure it.

Chapter 3 A WinSPIRS user How to use the 
different WinSPIRS 
screens

Chapter 4 A WinSPIRS user How to search using 
WinSPIRS
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Contacting Ovid

To learn more about Ovid software, or if you have any queries about 
installing and running the WebSPIRS software, please contact us in one 
of the following ways:

support@ovid.com

Call yourdistributor, or one of the following Technical Support teams:

Chapter 5 A WinSPIRS user How to use the records 
you find: marking, 
sorting, printing, and 
downloading records, 
and changing various 
options.

Chapter 6 A WinSPIRS user An alphabetical list of 
menu items and 
buttons.

Read... If you are... It will tell you...
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For the Americas:

Boston Office:

Tel: 1-781-769-2599

1-800-343-0064 (US/Canada)

Fax 1-781-769-8763

For Europe, Africa, Middle East, and South Asia:

London Office:

Tel: +44 (0) 20 8585-6400

0800-262-096 (UK)

Fax: +44 (0) 20 8585-6640

Amsterdam Office:
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Via the Ovid web site www.ovid.com

Tel: +31 (0) 20 6259650

Fax: +31 (0) 20 6237408

Berlin Office:

Tel: +49 30-85 77 99-0

Fax: +49 30-85 77 99-99

For Asia:

Hong Kong Office

Tel: +(852) 2806 2270

Fax: +(852) 2804 2746

For Australasia:

Tel: +61 2-9231-5599

Fax: +61 2-9231-5086
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This chapter provides details on installing WinSPIRS including:

• If you have an earlier version of WinSPIRS

• Checking hardware and software requirements

• Installing WinSPIRS from the FTP site

• Standalone installation instructions

• Network installation instructions

• Configuring WinSPIRS

• Accessing databases on network directories

• Setting up SilverLinker

• Providing Library Holdings Information

If You Have an Earlier Version of WinSPIRS

To upgrade install WinSPIRS 5.0 over an existing version of WinSPIRS. 
To do this, select the same directory as the existing version of WinSPIRS 
for the WinSPIRS 5.0 installation. The installer runs the uninstaller for 
the existing version of WinSPIRS, but applys the existing configuration 
to the new version.
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Checking Hardware and Software Requirements

Before you start to install the software you must check the hardware 
requirements for your platform.

For the very latest information about hardware requirements, please see 
the web site at: http://www.ovid.com/site/support/erlclientreq.jsp

Getting the Software

The ERL software and full documentation set is available on the ftp site. 

Downloading with a 
Browser

1. Access the web site; http://www.ovid.com

2. Click on the link to the ftp site, and click on Software, then on 
winspirs5.0

3. Double-click on each file to download it. The files are:

• winSPIRS50.exe

• The WinSPIRS User Manual (this manual - winman50.pdf)

Downloading from 
the ftp Site

1. Use ftp to connect to the site: ftp.silverplatter.com

Login with the username and password supplied by Ovid. 

2. Change to the /winspirs directory.

(To do this, enter cd /winspirs)

3. Make sure you will download the files as binary files. 

(To do this, enter bin)

4. Download all the files from the directory. 

(To do this, enter mget *. You are prompted to enter y to agree to 
download each file.)

The files will download into whatever is your local directory. The 
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files are:

• winSPIRS50.exe

• The WinSPIRS User Manual (this manual - winman50.pdf)

Installing the Software

Installing a version 
from the ftp site

If you downloaded software via FTP, double-click on winSPIRS50.exe 
to run the installation wizard.

The WinSPIRS installation wizard lets you install WinSPIRS as a 
standalone or shared application.

When you start the insllation wizard it checks whether WinSPIRS 5.0 is 
already installed on the machine. If it is already installed, you are offered 
the option to remove, repare, or modify the existing installation. The 
modify option allows you to change which features (e.g., local language 
interfaces) are installed. This functionality can also be accessed from the 
Windows Add/Remove Programs dialog.

Standalone Installation Instructions

1. Run winSPIRS50.exe.

2. Select the Language for the License Agreement and click Next.

3. Read the license and click Yes to accept the License Agreement.

4. Select a Program Folder in which to install WinSPIRS (the default 
is Program Files\WinSPIRS 5.0) and click Next.

5. Select the elements you wish to install. These are the WinSPIRS, 
Reconfig, and ERLedit executables, French, German, and Spanish 
interfaces.

6. Click Finish to finish the installation.

This installs the elements you selected in step 4, and where 
necessary the font Courier-LD, and runtime libraries.
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Network Installation Instructions

If you install WinSPIRS as a shared application on a server, for example, 
you need to install some software on the server and some on the client 
machines. 

First Stage: Installing 
on the Server

1. Working on the server (not remotely from a client machine), run 
winSPIRS50.exe.

2. Select the Language for the License Agreement and click Next.

3. Read the license and click Yes to accept the License Agreement.

4. Select a Program Folder in which to install WinSPIRS (the default 
is Program Files\WinSPIRS 5.0) and click Next..

5. Select the elements you wish to install. These are the WinSPIRS, 
Reconfig, and ERLedit executables, French, German, and Spanish 
interfaces. You must select the Network Installer option.

6. Click Finish to finish the installation.

This installs the elements you selected in step 4, and where 
necessary the font Courier-LD, and runtime libraries.

Second Stage: 
Installing on the Client

1. Working on each client machine (not remotely from the server), run 
the setup.exe that is in the server’s WinSPIRS directory. This 
version of setup differs from the one in the initial WinSPIRS 
installation files, which won’t now be called setup.exe. This creates 
a shortcut to the WinSPIRS executable on the server machine and 
installs fonts and runtime libraries if necessary.

Configuring WinSPIRS

WinSPIRS is installed with a number of default options that determine 
various settings, such as how records are displayed, printed, and 
downloaded. You can modify these options at any time after installation 
with the WinSPIRS Reconfiguration program.

To run the WinSPIRS Reconfiguration program:
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1. Select Reconfig from the Start menu.

2. Configuration Options menu.

FIGURE 2-1 Configuration Options menu

The following list shows the options available

Refer to the online Help for detailed information about the configuration 
options and default settings.

Option Use

Record Display Options Change the display of records

Search Options Set Fast Phrase searching, and 
display of intermediate results

Print Options Set print options

File Options Set download options

Workstation Options Set general display and search 
parameters for this workstation

Library Holdings Options Set up links to library holdings

ERL Options Set up ERL server access

Revert to Default Settings Reset each configuration to its 
default setting
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3. Click the option you want to change, such as ERL Options...

4. Modify the options as desired. 

5. Click OK to save the changes.

6. If necessary, click Revert to Default Settings to reset each 
configuration option to its default setting. Note that this option 
erases all ERL settings.

7. When you have finished, click the Save button.

Accessing Databases on Network Directories

To access databases on network subdirectories:

1. Open the file winspirs.ini in the WinSPIRS directory, using any text 
editor.

2. In the [CORE] section of winspirs.ini make sure that MAGDRIVE= 
is set to 1, and edit DRIVES= to specify the directories for the 
databases you want to access. Enter the databases as a list separated 
by semi-colons (;). You can include UNC or drive-letter based 
paths. You can use the wildcard * at the lowest level of a path to 
include all the databases in that subdirectory.

For example: to allow access to all the databases in directories one 
level under DBASES on the machine SERVER, you would enter:

[CORE]
DRIVES=\\SERVER\DBASES\*
MAGDRIVE=1

3. Save winspirs.ini as unformatted text and close the file.

Setting up SilverLinker

WinSPIRS 5.0 includes support for the SilverLinker database, which 
provides links from bibliographic records to the full text of articles in 
electronic journals to which your library subscribes. 
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The SilverLinker database contains URL links from articles. These links 
are displayed dynamically within SilverLinker-enabled bibliographic 
databases. The links appear as hotlinks in a separate field with the short 
name FTXT and link directly to the website where the full text article is 
located.

SilverLinker full-text links are displayed only when the SilverLinker 
database, and your bibliographic databases, are installed on ERL 
dbserver 4.0, or later. They are not available for databases accessed 
directly by WinSPIRS. In addition, your institution must have 
subscriptions to electronic journals at the web site or sites that host the 
full text. 

For more information about SilverLinker see the ERL Administrator’s 
Manual available at the ftp site, for example at: 
ftp://ftp.silverplatter.com/software/erl-server/solaris/

Note: Users must display the FXTF field to see SilverLinker links.

Providing Library Holdings Information

The Holdings Conversion Utility (HCU) lets you display local holdings 
information about SilverPlatter bibliographic databases.

About the Holdings 
Conversion Utility 
(HCU)

HCU converts a library’s serials holdings file (in ASCII or MARC 
format) into a SilverPlatter formatted file which, when installed on a 
server or stand-alone system, can be used to display local holdings 
information along with SilverPlatter bibliographic records. HCU-
generated files support the display of holdings information within any 
ISSN-based database. HCU can be installed on either a Windows 32-bit 
platform or a UNIX platform.

WinSPIRS 5.0 supports library holdings for all databases supported by 
the Holdings Conversion Utility (HCU). 

If users have a browser running on a WinSPIRS 5.0 workstation, 
WinSPIRS 5.0 also supports holdings messages with embedded URLs. 
(Earlier versions of WinSPIRS do not support URLs embedded in 
holdings messages.)
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For details of how to create library holdings information, see the 
Holdings documentation available on the ftp site, for example at: 
ftp://ftp.silverplatter.com/software/hcu/solaris/. 

About SPLHA WinSPIRS 5.0 does not support files generated by the earlier utility: 
SilverPlatter Library Holdings Administration (SPLHA). These files 
need to be converted to the new format using utilities provided in the 
HCU package.

For details of how to create library holdings information, see the HCU 
documentation. 

Making Holdings 
Information Available

To make holdings information available:

1. Choose the Reconfig icon from the WinSPIRS menu.

2. Click Library Holdings Options... on the Configuration Options 
screen to display the Library Holdings Options dialog box.

3. Check Holdings Exist, and specify the directory in which the 
holdings file is located.

4. Click OK to close the Library Holdings Options dialog box.

5. Click Save to save your changes and exit the Configuration Options 
screen.

Note: Make sure that the default setting for the fields WinSPIRS 
displays includes the *LHM field, to give your users access to library 
holdings information.

Disabling Holdings 
for Specific 
Databases

WinSPIRS 5.0 lets you exclude holdings information for specific 
databases. If you do this, holdings messages do not appear in records 
from the databases you specify. This mechanism applies only to locally 
mounted databases. Records from databases accessed using an ERL 
server will still show holdings messages, unless holdings from these 
databases are disabled at the ERL server.

To disable a database from displaying holdings messages:

1. Open winspirs.ini in a text editor.

2. Go to the first section, which starts with [ ].
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3. Find tag !42. Delete the semi-colon (;) at the beginning of the tag. 
(This makes the tag active.)

4. Enter a comma-delimited list of the database families for which you 
do not want holdings messages to display. 

The default is for holdings messages to display for all SilverPlatter 
databases. If you explicitly list in this file some subset of your data-
bases for which holdings message display is disabled, holdings mes-
sages will display only for those database families you have not 
included in the list. 

For example:

If your library subscribes to the following databases:

• SilverPlatter Medline (MEDS)

• PsycInfo (PY)

• Sociological Abstracts(SO)

• Cinahl (NU)

you might want holdings messages to display only for SilverPlatter 
Medline and PsycInfo. So you add the following to winspirs.ini:

!42=SO,NU 

Note: You must enter the database family names, and you must sep-
arate each with a comma.

An example line appears in winspirs.ini, commented out by an initial 
semicolon.

Default Holdings 
Messages

You can enable the display of default holdings messages for situations 
when WinSPIRS cannot identify a message to display from your HCU-
generated holdings file. The most common occurrence of this would be 
for journals that your library does not subscribe to, although other 
circumstances might also cause this.

Note: This mechanism applies only to locally mounted databases. 
Records from databases accessed using an ERL server will not show 
these messages. A similar mechanism is available for configuring an 



2–10  Installing WinSPIRS
ERL server to provide default messages. See the ERL Administrator’s 
Manual for details.

The winspirs.ini file contains a list of numeric tags and text messages 
associated with various conditions that result in no holdings information 
being available for display: 

;!50=Holdings files missing or incomplete 
;!51=Holdings files have no compatible keys
;!52=Holdings for this database family disabled 
;!53=No holdings key field in record 
;!54=No holdings key found in field 
;!55=The holdings key in this record is invalid 
;!56=Holdings index file corrupt - rebuild 
;!57=No holdings information for this record

You specify which of these messages you want to display, and you can 
change the text displayed. 

To change the default holdings messages:

1. For any condition for which you would like a default message to 
display, open the winspirs.ini file in your text editor.

2. Delete the semi-colon (;) at the beginning of the tag which 
corresponds to the condition for which you would like a default 
message to display. 

You can leave the text as it is, or edit the text to display any wording 
you wish. If messages span multiple lines, you must type \n at the 
end of each separate line of text at the point where you wish the line-
break. If you press [Enter] at the end of a line, the message will be 
truncated at that point. 

For example:

If you want to display a message for journals that your library does 
not subscribe to, locate tag !57 and delete the semi-colon (;). You 
might want to replace the default text:

No holdings information for this record

with appropriate text such as:

The library does not subscribe to this\n
journal. Please ask library staff\n
for help in getting this article.
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Languages

WinSPIRS 5.0 is available in English, French, German, and Spanish. 
During installation you can specify the languages in which the interface 
and online helpis available.
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This chapter introduces you to the basics of using WinSPIRS: 

• Starting WinSPIRS

• Selecting a database

• WinSPIRS at a glance

• Getting online help

• Ending a search session

You should be familiar with basic mouse techniques and WinSPIRS 
conventions as outlined in the Introduction.

WinSPIRS allows you to search both full-text and bibliographic 
databases. Except where specifically mentioned, the term “database” 
refers to both types of database.

Starting WinSPIRS

There are several ways to start WinSPIRS. The easiest is select 
WinSPIRS 5.0 from the Start menu.

Other methods are:

• Double-click on winspirs.exe in Windows Explorer

• Run winspirs.exe from the Run command in the Taskbar’s Start 
menu
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Once you launch WinSPIRS, you can choose the databases you want to 
search.

Selecting a Database

When started, WinSPIRS displays a database title screen or database 
selection screen, depending on how many databases are available.

If multiple databases 
are available:

If you have access to multiple databases, WinSPIRS displays the 
Available Databases dialog.

FIGURE 3-1 Selecting databases

Depending on the source and type of available databases, this list 
includes the server names (for databases on ERL servers), database 
names, and coverage dates (if available)

To select databases from the list:

1. Click on the title of the database you want to select. 

To select multiple databases, hold down [Shift] or [Ctrl] while click-
ing on the databases titles.

1. Click to highlight
database

2. Click Add

Selected databases
listed here

3. Click OK to accept
selection
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2. Click vvAddvv to select the highlighted database. 

3. Click OK. WinSPIRS displays the first database title screen and the 
Title Screen dialog box,.

FIGURE 3-2 A database title screen

This screen provides the coverage dates, scope, and copyright infor-
mation for the current database.

4. Click Next and Previous to view the remaining title screens.

5. Click OK to open the Search screen and begin your search.

If only one database is 
available

If only one database is available, WinSPIRS automatically displays the 
database title screen, as shown above.
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WinSPIRS at a Glance

WinSPIRS consists of the following screens:

• Search

• Index

• Thesaurus (for databases that include a Thesaurus)

• Table of Contents (for full-text databases)

All screens include a menu bar and a button bar at the top of the screen. 
From there you have access to the commands, dialog boxes, and screens 
that are available to you.

Click the icons on the button bar for access to their associated functions 
and screens. 

The menu bar contains the menus from which you select commands and 
dialog boxes. Menus and commands vary slightly depending on which 
WinSPIRS screen is displayed. Some of the menu commands are 
available on the button bar or as buttons elsewhere on the screen.

Click this button: To open or move to:

Available Databases dialog box

Print Records dialog box

Download Records dialog box

Search screen

Index screen

Table of Contents screen

Thesaurus screen
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File Menu

The File menu contains commands to save and reuse your search history, 
to output your search results to a disk or to a printer, and to select other 
databases to search. This menu also enables you to restart or exit 
WinSPIRS.

Edit Menu

The Edit menu contains commands to copy and paste text and clear the 
search history or text entry area.

Utilities Menu

The Utilities menu lets you view suggested terms, view loaded 
databases, and select fields to search.

Records Menu

The Records menu lets you display marked records, sort records, show 
held titles, and move the cursor around the list of retrieved records.

Mark Menu

The Mark menu lets you mark and unmark records. If you are searching 
a full-text database, you can mark portions of the records.

Options Menu

The Options menu lets you set (for a single search session) how 
WinSPIRS prints, shows, and saves retrieved records. This menu also 
lets you: show intermediate results, show hits per database (when 
searching more than one), have records display automatically, and 
change language interfaces (if available). 

Views Menu

The Views menu lets you move among the WinSPIRS screens, and 
expand your view of portions of the screen. For example, on the Search 
screen, you can expand the view of the Search History area to cover the 
entire screen.
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Help Menu

The Help menu gives you access to the various types of help available in 
WinSPIRS. “Getting Online Help” on page 3–11Getting Online Help 
provides more information on the Help menu.

Search Screen The Search screen lets you perform searches and view the records 
retrieved by those searches. The major components of this screen are 
labeled in the figure below. For more detail about using the Search 
screen, see “Using the Search Screen” on page 4–2Using the Search 
Screen.

FIGURE 3-3 WinSPIRS Search screen

To perform a search, type a term in the Search: text entry area and click 
Search. WinSPIRS lists the search in the Search History area and 
displays the records containing your search terms in the Retrieved 
Records area.

The Search History area is a list of searches performed during a session. 
Each line in the Search History shows one search and the number of 
records it retrieved.

Menu bar

Button bar

Search: text entry area

Search History area

Retrieved Records status area

Retrieved Records area
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The Retrieved Records status area provides information about the active 
record including the database name and the number of the active record, 
for example 1 of 7 in search #1. The active record is indicated by a 
blinking cursor.

The left side of the Retrieved Records area is the record-marking area. In 
this portion of the screen, each record is identified with a book icon. You 
can click on this icon to mark the record for later printing or 
downloading. 

Index Screen The Index screen lets you look for particular terms and view the records 
that include those terms. The major components of this screen are labeled 
in the figure below. For detailed information about using the Index 
screen, see “Using the Index” on page 4–12Using the Index.

To display the Index screen, click Index on the button bar, choose Index 
from the Views menu, or press [F5].

FIGURE 3-4 Index Screen

To look up a term, type it in the Index: text entry area. The Index Terms 
area scrolls to find the closest match to your term.

Menu bar

Button bar

Index: text entry area

Index Terms area

Retrieved Records status area

Retrieved Records area
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When you find a term, you can show the records in which the term is 
found in the Retrieved Records area or search for the term (which returns 
you to the Search screen.) You can select and search for multiple terms. 
You can also change indexes.
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Thesaurus Screen Many databases include a thesaurus: a list of controlled vocabulary used 
to standardize the indexing in the database. This lets you select and 
search for synonyms and preferred terms, and also to see descriptions of 
the terms. Also, if the database’s thesaurus is arranged hierarchically, 
you can select more general and more specific terms. For detailed 
information about using the Thesaurus screen, see “Using the 
Thesaurus” on page 4–15Using the Thesaurus.

Note: If you are searching multiple databases from different database 
families, the Thesaurus is unavailable.

To display the Thesaurus screen, click Thesaurus on the button bar, 
choose Thesaurus from the Views menu, or press [F9].

FIGURE 3-5 Thesaurus displaying the Permuted Index

To look up a term, type it in the Thesaurus: text entry area and click the 
Look Up button. The Permuted Index scrolls to find the closest match to 
your term.

You can view the index of thesaurus terms, get a brief description of the 
term and how it is used in the thesaurus, and select terms and search for 
records containing them.

Thesaurus: text entry area

Permuted Index
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Table of Contents 
Screen

Full-text databases are organized into hierarchies that you can view on 
the Table of Contents screen. For detailed information about using the 
Table of Contents screen, see “Using the Table of Contents” on page 4–
23Using the Table of Contents.

To display the Table of Contents screen, click Contents on the button 
bar, choose Table of Contents from the Views menu, or press [F3].

FIGURE 3-6 Table of Contents screen

To locate a record in the Table of Contents, you can expand the 
appropriate branches until you reach the level of the record, identified 
with the book icon. 

You can also display the contents of individual records in the Table of 
Contents area. You can then select the portion of the record you want to 
view. 

Highest level of data-
base Table of Contents

Book indicates a record

Associated record

Page indicates a section
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Getting Online Help

Online help is available both for WinSPIRS and for the databases you are 
searching. You can get context sensitive help for screen areas and dialog 
boxes. By using the Help menu, you can get help on all menu items, 
WinSPIRS commands, and search techniques through a variety of topics 
from which you can choose. You can access database guides: 
information specific to the database you are using, and you can even get 
help on how to use the help system.

Displaying Online 
Help

Press [F1] or click Help to access context sensitive help, or use the Help 
menu to move through Help topics. 

FIGURE 3-7 A typical help window

The WinSPIRS help system uses Windows standards; if you have used 
any other Windows applications, you may be familiar with the help 
system.

Click Contents for a hierarchical list of help topics, or Index for an 
alphabetical list. Click Search to search a list of keywords.

Getting Database-
Specific Help

Each database comes with a guide, help information unique to that 
database. To see the guide for the database you are using, choose Guide 
from the Help menu.
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For each loaded database you will see two entries in the Guide submenu.

FIGURE 3-8 A typical Guide submenu

The first choice displays a list of all topics covered in the database guide. 
The second choice displays all the fields in the database. Some of the 
topics typically included in the guide, in addition to the fields, are an 
introduction to the database, sample searches, lists of special codes, and 
a list of stopwords.

Ending a Search Session

When you are finished searching, you can either exit WinSPIRS or 
restart to leave it ready for the next user.

To exit WinSPIRS, choose Exit from the File menu.

To restart, choose Restart.... 

In either case, you are given the opportunity to save marked records or 
your search history before closing WinSPIRS.
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Chapter 4 Searching with WinSPIRS

You can search for records in a variety of ways, depending on your 
search concepts, the database you are searching, and your preference. 
The first part of this chapter illustrates the various techniques of using the 
Search screen:

• Performing a Simple Search

• Valid Search Statements

• Using Truncation and Wildcards

• Searching for Hyphenated Phrases

• Using Parentheses

• Combining Terms with Operators

• Searching in Specific Fields

• Searching in Limit Fields

• Using the Suggest Feature

The second part of the chapter addresses some of the more advanced 
WinSPIRS functions:

• Using the Index

• Using the Thesaurus

• Using the Table of Contents

• Using the Search History
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• Searching Multiple Databases

• Narrowing and Broadening Your Search

Using the Search Screen

The first step in a search is to decide what you are searching for. Identify 
terms or concepts that describe your search objective. Once you have 
your topic, think of the search terms that represent the search topic.

Next, evaluate your search terms in relation to the database: do they 
adequately describe the topic? Will they be too specific or too general? 
The answers to these questions depend on many factors including the 
scope of the database you choose to search.

Once you identify the objective of your search, you can determine how 
to search the database. The simplest way to search is described below.

Performing a Simple 
Search

To search for a term or phrase:

1. Type a term in the Search: text entry area. 

FIGURE 4-1 Searching

2. Click Search. WinSPIRS lists the results of your search in the 
Search History.

FIGURE 4-2 Results of a simple search
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Note that the results of the individual terms of a phrase are included 
if you have Show Intermediate Results turned on in the Options 
menu.

3. If necessary, click Show in the Search History. WinSPIRS displays 
the records retrieved by your search. 

FIGURE 4-3 Records retrieved by a search

Note that the records are displayed automatically if you have 
Automatic Records Display turned on in the Options menu.

Refer to the following sections in this chapter for information on refining 
your search. Remember online help is available: press [F1] or use the 
Help menu.

Valid Search 
Statements

Below are examples of search requests that you can type in the Find 
Records dialog box. Each request can be up to 1024 characters long. 

Description of Search Example

A term dog

A term with truncation comput*

A term with wildcards colo?r

A number 1994

Letters and numbers combined 3m

A phrase new york city

A hyphenated phrase drug-abuse

A phrase with operators in quotes “near” death experience
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Using Truncation and 
Wildcards

You can retrieve variations of a search term by using truncation and 
wildcards. This is a useful way of broadening a search that has retrieved 
too few records.

The truncation symbol (*) serves as a substitute for any string of zero or 
more characters. For example, type cardio* to retrieve cardiology, 
cardiogram, etc.

The wildcard symbol (?) serves as a substitute for one character or none. 
For example, type m?cdonald to retrieve McDonald or MacDonald.

The truncation and wildcard symbols can be used anywhere in your 
search term, except as the first character. 

Searching for 
Hyphenated Phrases

Often, when a database is set up, the individual words of a phrase are 
“bound” with hyphens so that the complete phrase can be indexed, rather 
than just the individual words. For example, authors’ names are 
hyphenated so that the first and last names are kept together in the Index. 
Similarly, controlled vocabulary terms, such as descriptors, are 
hyphenated so that key phrases are kept intact.

When searching a field that uses hyphens, you can include them in or 
omit them from your search request to make the search more or less 
focused. To determine which fields use hyphens, take note of the fields 
in a retrieved record or refer to the database Guide in the Help menu.

A term or phrase limited to a field smith in au

A previous search request
number

#3

Any of the above, combined with 
operators

3m and #2

Any of the above, separated by 
semi-colons

drug-abuse;#4;smith in au

Any of the above, grouped
with parentheses for clarity

(canine or #1) near puppy

Description of Search Example
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Including Hyphens for a Focused Search

If the field you are searching uses hyphens, you can hyphenate your 
search term to retrieve only occurrences of that term. 

For example, if you are searching the Descriptors (DE) field, the search 
request marine-aquaculture in de retrieves only occurrences 
of marine-aquaculture. Similarly, in the Authors (AU) field, the search 
lindeman-c in au retrieves only records authored by C. Lindeman.

Alternatively, you can select hyphenated phrases from the Index. See 
“Using the Index” on page 4–14 for more information.

Omitting Hyphens for a Broad Search

If the field you are searching uses hyphens, you can omit them from your 
search term to retrieve variations of your term. For example, if you are 
searching the Descriptors (DE) field, the search request 
marine in de retrieves occurrences of marine, marine-aquaculture, 
marine-crustaceans, marine-environments, and so on. Similarly, in the 
Authors (AU) field, the search lindeman in au retrieves records 
authored by A.K. Lindeman, C. Lindeman, C.A. Lindeman, and so on.

Using Parentheses Use parentheses to avoid ambiguity in complex search statements. 

For example, suppose you want to retrieve records that discuss rabies in 
dogs or rabies in cats.

The search request rabies and dogs or cats retrieves records 
that discuss rabies and dogs, and records that discuss cats, but not 
necessarily records that discuss rabies and cats.

The search request rabies and (dogs or cats) retrieves records 
that discuss rabies and either dogs or cats, which is what you intended.

If you omit parentheses from a complex search statement, WinSPIRS 
automatically inserts them. Check the Search History window to see if 
WinSPIRS’ interpretation is what you intended. If it is not, click Cancel 
to stop the search and edit the search request.
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Combining Terms 
with Operators

Operators are words that have a special meaning in WinSPIRS. You can 
use them to combine search terms into a more complex search statement.

Operator What It finds

and Records that contain both of two search terms. 

For example, dyslexia and child retrieves 
records containing both dyslexia and child. 

Shaded area represents records containing the term 
dyslexia and the term child

with Records that contain both of two search terms in the 
same field. 

For example, the search dyslexia with 
research retrieves records that contain both 
dyslexia and research in any one of the database 
fields.

near Records that contain both of two search terms in the 
same sentence. 

For example, dyslexia near treatment 
retrieves only those records where dyslexia and 
treatment are in the same sentence (either term can 
appear first).

You can add a number to near to specify exactly how 
close the terms should be. For example, language 
near2 computer retrieves records containing 
language within two words of computer, in any order, 
in the same sentence.

 (Sheet 1 of 3)

dyslexia child
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adj Records that contain two adjacent terms in the order 
you specify. 

For example, the focus of the search "racing 
bicycle" is different from that of "bicycle 
racing." The adjacent operator means WinSPIRS 
searches for the two terms in the order you specify, 
thus preserving the focus of your search. 

adj also lets you search for identical, adjacent terms, 
such as "gorilla adj gorilla." This is useful for 
searching biological classifications, in which several 
organisms have identical genus and species names, 
such as "bufo bufo."

You cannot use adj to combine the current search 
with a previous one.

or Records that contain either or both of two search 
terms. 

For example, the search dyslexia or learning 
disabilities retrieves all records that contain 
dyslexia, learning disabilities, or both dyslexia and 
learning disabilities. 

Shaded areas represent records containing the term 
dyslexia or the term learning disabilities

Operator What It finds

 (Sheet 2 of 3)

dyslexia learning
disabilities
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To combine terms with an operator:

1. Enter your first term in the Search: text entry area.

2. Type the operator you want to use after your first term.

3. Enter your second term after the operator.

FIGURE 4-4 Searching for either of two synonyms

not Records that contain the first of two search terms, but 
not the second. This can be helpful for eliminating 
false hits.

For example, truman not capote retrieves 
records that contain Truman and do not contain 
Capote (references to the president but not the writer.)

not should be used carefully, however, because it 
can also eliminate useful records. 

For example, if you search for dog not puppy, you 
will miss records that discuss both dog and puppy.

Grey area represents records retrieved by dog not 
puppy; Black area represents relevant records 
eliminated by dog not puppy

Operator What It finds

 (Sheet 3 of 3)

dog puppy

relevant records
eliminated



Using the Search Screen 4–9
In
tro

d
u

ctio
n

4. Click Search.

Searching in Specific 
Fields

You can narrow your search by limiting it to a particular field or group 
of fields in the database. By searching only in relevant fields, you can 
eliminate false hits.

For example, suppose you are looking for the works of a particular 
author. Rather than search the entire database, you can search only those 
fields that contain author information, such as the Author (AU) and 
Corporate Author (CA) fields. 

To search in a specific field:

1. In the Search: text entry area, type a term or phrase followed by in 
and the label of the field you want to search. 

For example, to search for Freud in the Author (AU) field, type 
freud in au.

To search in multiple fields, separate the labels with commas, such 
as freud in au, su.

2. Click Search.

You can also select field labels from a list and add them to your search:

1. Select Fields to Search... from the Utilities menu. WinSPIRS 
displays the Field List dialog.

FIGURE 4-5 Field List dialog box

2. Highlight the fields in which you want to search and click Add to 
Search.
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Field-specific indices also provide a way to search particular fields. For 
more information, see “Using the Index” on page 4–14.

Searching in Limit 
Fields

Each database contains several specially indexed fields called limit 
fields. Limit fields typically contain information common to a large 
number of records, such as publication year or language. A limit field 
search can be very helpful in combination with other search statements.

When you search for terms in limit fields, you must use the field label, 
along with the in operator, the = operator, or, if the limit field contains 
numeric data, one of the range operators described in the table below. 

For example, to search for articles published in French, you might search 
the Language (LA) field as follows: french in la or 
la=french.

In limit fields that contain numeric values, such as publication year, you 
can also use the following special range operators:

Note: When you search without specifying a field (such as the statement 
french), or if you search from the free-text index, limit fields are not 
searched. 

Limit fields vary according to the database. Click Limit... in the Search 
History area for a list of the limit fields in the database you are using or 
refer to the online Guide. 

You can perform a limit search by entering your search statement in the 
Search: text entry area or by selecting a search from the Search History 
and applying a limit search.

1. Click on a search listed in the Search History.

Operator What it Means Search Example

< less than py<1986

> greater than py>1984

<= less than or equal py<=1985

>= greater than or equal py>=1984

- within a range py=1983-1986
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2. Click Limit... to display the Limit Search dialog box.

FIGURE 4-6 Limit Search dialog box

3. Select a limit field from the Limit Search By: portion of the dialog 
box.

4. Select the limit operator you want to use, such as Equals.

5. Select a limiting value from the Limiting Values: portion of the 
dialog box. The search you are constructing appears at the bottom of 
the dialog box. 

6. Click OK. 

WinSPIRS performs the search and displays the results in the Search 
History and Retrieved Records areas of the Search screen.

Using the Suggest Feature

The Suggest feature, or Automatic Subject Lookup, provides you with a 
list of suggested terms related to your search request. These suggested 
terms are taken from the database’s controlled vocabulary and appear in 
a window that lets you search or display definitions.

Suggested terms are available only with certain databases, and only if 
you are searching a single database. The Suggest button is grayed out if 
the feature is unavailable.
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To use the Suggest feature:

1. Type a word or phrase in the Search: text entry area.

2. Click Suggest. WinSPIRS displays a list of suggested terms in the 
Suggestions dialog box.

FIGURE 4-7 Suggestions for the term “hernia”

3. Click on a suggested term.

4. Click Definition to display a description for the highlighted term.

5. Search for the suggested term:

• Click Search to search for the term without any narrower 
terms.

• Click Explode to search for the term and all its narrower 
terms. (Note: Exploding is unavailable if the database does 
not have a hierarchical thesaurus.)

Using the Index

The Index lists all the searchable terms in the database and indicates the 
number of records that contain each term. Many databases have more 
than one index. For example, a database can have an index for the Author 
field, and a separate index for the Title field. The Index is especially 
useful for finding hyphenated phrases and variations of authors’ names. 
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Note: Words that appear too frequently to be used in searching are 
omitted from the Index; these are called “stopwords” and are listed in the 
database Guide in the Help menu.

Looking Up an Index 
Term

To look up an index term:

1. Click Index on the button bar. WinSPIRS displays the Index screen.

2. Type a term in the Index: text entry area.

FIGURE 4-8 Looking up “coronary” in the Index

WinSPIRS displays the Index Terms, with your term, or its closest 
match, highlighted.

FIGURE 4-9 Index Terms

3. Scroll through the Index Terms. For each term, WinSPIRS displays 
the number of records that contain the term and the total number of 
occurrences of the term.

4. Click on any term of interest. WinSPIRS highlights the term.

5. Click Show to preview the records that contain the term. (Show is 
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grayed out if you have more than one term selected.)

FIGURE 4-10 Records containing the index term “coronary”

You can scroll through the records, change their display, and print 
and download them as with records in the Search screen, but the in-
dex terms are not added to your search history until you search for 
them, as described below.

Searching for Index 
Terms

You can preview, print, and download records that contain a particular 
index term, but the term is not added to the Search History until you 
search for the term. After you search for an index term, you can combine 
the search with other searches, limit the records retrieved by the search, 
and save the search as part of your Search History.

To search for index terms:

1. Select one or more terms. To select multiple terms, press [Shift] or 
[Ctrl] and click on the desired terms

FIGURE 4-11 Searching for multiple terms in the Index

2. Click Search. WinSPIRS adds the term(s) to the Search History. If 
you select multiple terms, WinSPIRS combines them with the or 
operator.
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Changing Indexes If the database you are searching has more than one index, you can 
change indexes as follows:

1. Click Change... or choose Change Index... from the Options menu. 
WinSPIRS displays the Available Indexes dialog box

FIGURE 4-12 Selecting an index

The Free Text Index is listed first and is the default. It indexes the 
fields listed in parentheses, and is a good index to search if you don’t 
want to limit your search to a specific field.

If you are searching more than one database, the indexes that are 
common to all the databases are listed under the heading “UNIVER-
SAL”, and unique indexes are listed under the database in which 
they occur.

2. Click on the desired index. 

You can select more than one field-specific index by holding down 
[Shift] or [Ctrl] and clicking on the indexes you want to search. 
However, the Free-Text index can only be searched by itself.

3. Click Select to select the index(es) you want to search and to return 
to the Index screen. The names of the selected indexes appear in 
parentheses next to the Index: prompt.

Using the Thesaurus

Many databases include a thesaurus, which is a list of controlled 
vocabulary terms used to standardize the indexing in the database. The 
Thesaurus enables you to select and search for synonyms, related terms, 
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and preferred terms. If the thesaurus is arranged hierarchically, you can 
select more general (broader) and more specific (narrower) terms.

Looking Up a 
Thesaurus Term

To look up a thesaurus term:

1. Click Thesaurus on the button bar. WinSPIRS displays the 
Thesaurus screen.

2. Type a term in the Thesaurus: text entry area

FIGURE 4-13 Looking up a term in the Thesaurus

3. Click Look Up. WinSPIRS displays the Permuted Index, with your 
term or its closest match highlighted.

FIGURE 4-14 Permuted Index, showing the descriptor phrases in which 
the term occurs

4. Scroll through the Permuted Index. It lists all the descriptor phrases 
in which each controlled vocabulary term occurs. You can get 
information and search for any term of interest, and you can add 
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terms to a list for batch searching.

Getting Information 
about a Thesaurus 
Term

The WinSPIRS Thesaurus includes a Term Information section, which 
provides details about a selected thesaurus term. The information 
provided depends on the database you are searching. It often includes a 
definition, scope notes, previous indexing terms, and related, broader, 
and narrower terms.

To get information about a thesaurus term:

1. If necessary, look up a term in the Thesaurus as described on page 
4–17.

2. Click on a term in the Permuted Index.

3. Click Term Information. WinSPIRS displays the Term Information 
screen.

FIGURE 4-15 Term Information, showing term notes, related terms, and 
tree structure (broader and narrower terms)

You can search for the term, add the term to a list to search for later, 
or get information on another term.

Notes, related terms
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Displaying Trees

Some thesauri display broader and narrower terms in a hierarchical 
structure called a “tree.” Trees are shown in abbreviated form in the 
Term Information screen. 

To display the complete trees:

1. If necessary, get information about a term as described above.

2. Select View Full Tree from the Options menu. WinSPIRS displays 
the Full Tree View screen. 

FIGURE 4-16 Full Tree View, showing the broader and narrower terms 
for “kidney”

The column of numbers on the left side of the tree indicates the level 
of each term in the tree. Broader, more general terms are indicated 
by lower numbers, and are listed further left than narrower, more 
specific terms.

You can search for, get information on, or add to a list any term in 
the tree.

Lower numbers indicate
broader, more general terms

Higher numbers indicate
narrower, more specific terms
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Searching for 
Thesaurus Terms

WinSPIRS allows you to search for thesaurus terms directly from the 
Permuted Index, Term Information, and Full Tree View screens. Once 
you select a term, you can search for it individually, or you can add it to 
a list of thesaurus terms for batch searching.

To search for thesaurus terms:

1. Select any term of interest in the Permuted Index, Term Information, 
or Full Tree View screen.

2. In the Search Options box, choose the type of search you want to 
perform:

• Select Single Term to search for the selected term without its 
narrower terms.

• Select Explode to search for the selected term along with its 
narrower, more specific terms. This is more comprehensive 
than searching for the term by itself. (If the thesaurus is 
organized into trees, you may be able to select the tree in which 
to explode the term.)

3. Click Search Now to perform the search, or click Add to List to add 
it to a list of searches to perform later.

4. If the thesaurus you are searching uses subheadings, WinSPIRS 
displays the Subheadings Selection dialog box. Select one or more 
subheadings and click OK. See “Selecting Subheadings” on page 4–
21 for instructions.

5. If you chose Search Now, WinSPIRS copies the term, and any 
subheadings, to the Search screen and performs the search.

If you chose Add to List, WinSPIRS copies the term, and any sub-
headings, to the Selected Term List. You can then view the list, add 
more searches to it, or perform all of the searches.

If You Have Built a List of Searches

Once you add a search to the Selected Term List, you can view the list, 
add more searches to it, or perform all of the searches.

To view the list:

• Click View List... in the Permuted Index, Term Information, or Full 
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Tree View screen. WinSPIRS displays the Selected Term List dialog 
box

FIGURE 4-17 Selected Term List with subheadings

To delete searches from the list:

1. Click on a search in the Selected Term List.

2. Click Clear. WinSPIRS deletes the term and any subheadings 
selected for that term.

To perform the searches:

• Click Search List in the Selected Term List dialog box. (You can 
also click Search List in the Permuted Index, Term Information, 
and Full Tree View screens.) WinSPIRS performs all of the searches 
and discards the list.

Selecting Subheadings

Subheadings are qualifiers used in some thesauri to describe specific 
aspects of terms. If the database uses subheadings, you need to apply one 
or more to your term before searching for the term.

To select subheadings:

1. When you click Search Now or Add to List in the Permuted Index, 
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Term Information, or Full Tree View screen, WinSPIRS displays 
the Subheadings Selection dialog box.

FIGURE 4-18 Subheadings Selection dialog box

2. Click on a subheading in the Choose from these Subheadings list.

3. If desired, click Description to view a short description of the 
subheading.

4. Click >>Add>> to add the subheading to the Use these Subheadings 
list.

5. Repeat steps 2 through 4 to apply additional subheadings to your 
term.

6. Click OK. WinSPIRS searches for the term and any subheadings, or 
adds the search to the Selected Term List.

Using the Thesaurus 
History

WinSPIRS keeps track of the thesaurus terms you view in the Thesaurus 
History.

To view the Thesaurus History:

• Select Show Thesaurus History from the Options menu. 
WinSPIRS displays the Thesaurus History dialog box. It displays 
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thesaurus terms you have viewed and indicates the screen in which 
each was viewed

FIGURE 4-19 Thesaurus History

To return to the display of a term:

1. Click on a term in the Thesaurus History.

2. Click OK. WinSPIRS returns to the screen in which you had viewed 
the term. 

Resetting the 
Thesaurus

At any point, you can clear the Selected Term List and Thesaurus 
History, and return to a blank Permuted Index screen. 

To reset the Thesaurus:

1. Choose Reset Thesaurus from the Options menu at the Permuted 
Index, Term Information, or Full Tree View screen. WinSPIRS 
confirms that you want to reset the Thesaurus.

2. Click Yes.
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Using the Table of Contents

Databases that provide the full text of documents are organized 
hierarchically. These full text databases include a Table of Contents, 
which is similar to that in a book: it provides an outline of the database, 
which may be organized by subject, publication, chronology, or other 
means.

The Table of Contents is not available for bibliographic databases that do 
not have full text.

Looking Up a Full Text 
Record

To look up a record in the Table of Contents:

1. Click Contents on the button bar. WinSPIRS displays the Table of 
Contents.

2. Click the plus icon:  to the left of a topic of interest. WinSPIRS 
displays the topic’s subtopics.

FIGURE 4-20 Expanded topics in the Table of Contents

3. Scroll through the subtopics and expand one of interest.

4. Continue expanding topics until you reach a level of topics that have 
book:  and page:  icons to their left. These icons represent 
records and sections of records, which you can display, as described 
below.

Showing Full Text 
Records

To show a record in the Table of Contents:

1. Click on any topic with a book:  or page:  icon to its left. 
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2. Click Show. WinSPIRS displays the text of the highlighted topic

FIGURE 4-21 Portion of a full-text record

3. Scroll through the text. Note that you can scroll to other topics in the 
Table of Contents.

4. If necessary, click Synchronize to scroll to and highlight the 
heading in the Table of Contents that corresponds to the currently 
displayed text.

You can mark, print, and download portions of the full text records. See 
“Marking and Unmarking Records” on page 5–17, “Printing Records” 
on page 5–19, and “Downloading Records” on page 5–22 for more 
information.

Using the Search History

The Search History area of the Search screen provides a numbered list of 
all your search requests and indicates the number of records retrieved by 
each. The Search History is updated with each search request.

You can reuse or clear any search from the Search History. You can also 
save your history and rerun a previously saved history.

Reusing Search 
Requests

You can reuse any search request in the Search History to combine it 
with a new search or to show, print, or save the records retrieved by it.

To combine a previous search with a new one:

1. Click on the desired search request in the Search History area and 
click Retype. The search statement is automatically placed in the 
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Search: prompt.

Alternatively, you can type the number of the desired search request 
in the Search: prompt.

2. Combine the search with additional terms using the available 
operators. For example, you could construct a search request, #1 
and freud in au.

3. Click Search. The Search History reports the number of records 
retrieved by the search request and the records are displayed in the 
Retrieved Records area.

To show, print, or save the results of a previous search:

1. Double-click on the desired search in the Search History window. 
WinSPIRS performs the search on the currently selected 
database(s). The records from the search are displayed.

2. Select Print Records or Save Records from the File menu.

See “Showing Records” on page 5–1, “Printing Records” on page 5–
19, and “Downloading Records” on page 5–22 for more informa-
tion.

Clearing Search 
Requests

During a search session you can clear searches from the Search History 
area. For example, before you save a search history you can eliminate the 
unwanted search statements for clarity.

1. Click the Clear... button in the Search History area or choose Clear 
Search History from the Edit menu. WinSPIRS displays the Clear 
Search History dialog box.

2. Indicate the searches you want to clear:

• Click All to clear the entire search. 

• Click Searches to enter the numbers of the searches to clear. 
Use commas to separate individual search statements and 
hyphens to identify a range of search statements. For example, 
to clear search statements 2 and 3 and search statements 7 
through 10, type 2,3,7-10.

3. Click OK. WinSPIRS renumbers the remaining searches, if 
necessary.
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Saving a Search 
History

WinSPIRS allows you to save your search requests and run them during 
future work sessions. This is especially useful for complex searches or 
those you perform on a regular basis.

Note: You may want to clear unwanted searches before saving, as 
described in the previous section.

To save your search history:

1. Choose Save Search History... from the File menu. WinSPIRS 
displays the Save Search History dialog box.

FIGURE 4-22 Saving a search history

2. Select the appropriate drive and directory from the lists provided.

3. The default name of your search history file is search.his. You can 
type a new name File Name text entry area.

4. Enter a brief description, up to 45 characters long. The description 
will be available when you run the history.

5. Click OK to save the search history. 

Running a Saved 
Search History

To run a previously saved search history:

1. Choose Load and Run Searches… from the File menu. WinSPIRS 
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displays the Run Search History dialog box.

FIGURE 4-23 Running a saved search history

2. Select the appropriate drive and directory form the lists provided.

3. Select a search history from the list of search history files.

4. If desired, click Description for a description of the selected search 
history.

5. Click OK to run the search history. WinSPIRS performs the searches 
and displays the results in the Search History area of the Search 
screen.

Note: If the search history is from a different database than the one 
you are currently using you can still run the search. However, if 
fields are searched in the search history that do not exist in the cur-
rent database, those search statements are identified with n/a in the 
results column; in other words, the results are not available.

Searching Multiple Databases

With WinSPIRS, you can search more than one database at a time. When 
doing so, you must keep the following in mind:

• The databases may not have all fields in common; if you search in a 
specific field (either in the Search screen or the Index), you will only 
retrieve records from those databases that contain the field.

• The Thesaurus is unavailable, even if each of the selected databases 
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has a Thesaurus.

• The Suggestions feature is unavailable.

• Each database has its own set of Guides in the Help menu.

See “Selecting a Database” on page 3–2 for instructions on selecting 
multiple databases.

Narrowing and Broadening Your Search

If your initial search request retrieves too many or too few records, you 
can narrow or broaden the search using the following techniques. These 
are discussed further in previous sections of this chapter.

To narrow your search:

• “Searching in Specific Fields” on page 4–9

• “Searching in Limit Fields” on page 4–10

• “Combining Terms with Operators” on page 4–6

• Select more specific terms by “Using the Index” on page 4–12 and 
“Using the Thesaurus” on page 4–15.

To broaden your search:

• “Using Truncation and Wildcards” on page 4–4, to retrieve 
variations of your search terms.

• “Combining Terms with Operators” on page 4–6

• Select broader terms by “Using the Index” on page 4–12 and “Using 
the Thesaurus” on page 4–15.

• “Searching Multiple Databases” on page 4–27)
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Once you have searched for and retrieved records of interest, you have 
several options, including displaying, printing, and downloading records, 
and marking a subset of records. You can also output records in a variety 
of formats by changing the Show, Print, and Download options.

Showing Records

You can show the records retrieved by any of your searches. 

To show records:

1. In the Search History area, click on the search you want to show; the 
search is highlighted.

2. Click the Show button to display records for the selected search.

Records are displayed automatically after each search if you select 
Automatic Records Display from the Options menu. You can turn this 
option off for faster searching, and then show retrieved records as 
described above.

Changing Show 
Options

You can determine how records are displayed by changing the Retrieved 
Records Options. These options include which fields are displayed, how 
field labels are displayed, and whether graphics are displayed within 
records.

To change show options:

1. Choose Show Options... from the Options menu. WinSPIRS 
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displays the Retrieved Records Options dialog box.

FIGURE 5-1 The Retrieved Records Options dialog box

2. Add the fields you want to show to the Display these Fields list.

Note: If the Make Default Fields button is available, you can make 
the selected set of fields the default for the current database. You 
will be asked to restart WinSPIRS; the new default will be effective 
every time you search the current database.

3. Indicate how you want fields to display in the Field Labels area:

• Short Field Names displays field abbreviations, such as “TI”.

• Long Field Names displays the full field names, such as 
“Title”.

• No Field Names omits field names from retrieved records.

4. Choose from the Other Options:

• Auto Full Screen shows a full-screen view of the retrieved 
records each time you click All Fields.

• Indent Text indents the text of retrieved records under the field 
labels.

• Show Graphics displays graphics within the text of retrieved 
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records.

Note: WinSPIRS always displays links to the graphics; Show 
Graphics determines whether graphics are displayed inline in addi-
tion to the links.

5. If desired, change the style of text in retrieved records:

• Click Font to set the font and size of text.

• Click Fixed Font to select from a list of monospaced fonts, in 
which all characters are the same width. These fonts are useful 
for aligning columns and tables in records.

6. Click OK to close the Retrieved Records Options dialog box.

Sorting Records You can sort up to 1000 retrieved records by a field that you choose. For 
example, you can sort records alphabetically by author, or 
chronologically by publication date. You can then show, print, or 
download the records in sorted order.

To sort records:

1. Choose Sort Records from the Records menu. WinSPIRS displays 
the Sort Records dialog box.

FIGURE 5-2 Sorting records chronologically by publication date

2. Choose Ascending or Descending as the method of sorting.

3. Click on the field to sort by.

4. Click OK. WinSPIRS displays a progress message as it sorts the 
records.
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Searching from Retrieved Records

You may see a word or phrase in a retrieved record that suggests an 
alternative search strategy. You can select the terms for searching and 
WinSPIRS automatically places them in the Search: text entry box. This 
process is often referred to as “lateral searching.”

Lateral Searching To make a lateral search:

1. Browse through the retrieved records. When you identify a term in 
one of the records that suggests another search, highlight the term by 
double-clicking or dragging across the term.

Note: Some words and symbols that might occur within records 
have a special meaning in WinSPIRS, (for example; operators such 
as AND and OR, stop words, such as “the”, and hyphens or { and }) 
Do not include such items in the text you highlight for lateral search-
ing.

2. Click Add to Search.

If there is text already in the Search box, WinSPIRS adds a semi-co-
lon ; (Search Separator) before adding the new text, so creating dif-
ferent search strings that can be run in sequence.

FIGURE 5-3 A term selected from the Title (TI) field

3. Click Search.

Displaying Hotlinked Records

In some databases, records are linked to other relevant records. The links 
between these records, called “hotlinks,” appear as a different color or 
shade of text within records.
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Look at the database Guide in the Help menu to see if the database you 
are searching has hotlinks.

To show a hotlinked record: 

1. Scroll through the retrieved records until you find a hotlink. Note 
that when you pass the mouse over the hotlink the cursor changes 
from an I-beam to a hand, as shown in the following figure:.

FIGURE 5-4 Retrieved record with hotlinks

2. Click on the hotlink. WinSPIRS displays the linked record in the 
Hotlink window.

FIGURE 5-5 Hotlink window
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3. Click Close to close the window. 

You can also leave the window accessible by minimizing it or send-
ing it to the background; you can later display it by selecting Hotlink 
Window from the Views menu.

SilverLinker Support

If your organization has set up support for the SilverLinker database, you 
will see a new field, called FTXT (meaning full text), in some of the 
displayed records. 

This field contains direct links to full text articles, located at publisher 
web sites. If you click on the link, your default web browser launches 
automatically, and links to the site containing the article. 

If you know that you have SilverLinker support but you do not see any 
records with full text links, check that you have set your options for 
displaying records to include the field FTXT. (See “Changing Show 
Options” on page 5–1.) If you still do not see any full text links, ask your 
WinSPIRS administrator which publisher sites you have access to: your 
search may not be finding any records for articles at those sites.

Displaying Local Library Holdings Information

When you look at records retrieved by a search, you may also see details 
of local library holdings: that is, information about whether your library 
has a copy of the publication, and, if so, where it is stored. The exact 
details you see depend on whether your WinSPIRS administrator has set 
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this feature, and the amount of detail about location and availability that 
they have decided to include. 

FIGURE 5-6 Examples of holdings information

You can only see holdings information if the *LHM field is supported by 
the database, and if you select them to display in the Retrieved Records 
Options dialog box. See “Changing Show Options” on page 5–1.

To display only records that have local holdings details:

1. Perform a search.

2. Choose Show Options... from the Options menu. 

3. In the Retrieved Records Options dialog box, select *LHM and add it 
to the list of displayed fields. Click OK.

4. Choose Show Held Titles Only from the Records menu.

Displaying Graphics

Some databases include graphics, which are linked to the retrieved 
records. The links appear as a different color or shade of text within 
records, and usually say “see graphics”. You can display linked graphics 
in a separate window or within the retrieved records.

Refer to the database Guide in the Help menu to determine if the 
database you are searching has graphics.

Information about
local library

holdings, using
the field *LHM
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To display graphics in a separate window:

1. Perform a search. The database Guide may suggest how to search for 
graphics.

2. Scroll through the retrieved records until you find a linked graphic. 
Note that when you pass the mouse over the link the cursor changes 
from an I-beam to a hand.

3. Click on the link. 

WinSPIRS displays the linked graphic in the Graphic window.

4. Click Zoom In and Zoom Out, and select Fit to Window from the 
View menu to resize the graphic.

5. Click Close to close the window. 

You can also leave the window accessible by minimizing it or send-
ing it to the background; you can later display it by selecting Graph-
ic Window from the Views menu of the Search, Index, Table of 
Contents, or Thesaurus screen.

To display graphics within records:

1. Perform a search. The database Guide may suggest how to search for 
graphics.

2. Select Show Options... from the Options menu. WinSPIRS 
displays the Retrieved Records Options dialog box.

3. Select Show Graphics in the Other Options box. 

4. Click OK. Graphics are displayed in the records, as shown below. 
Note that links to the graphics are included, allowing you display the 
graphics in a separate window.

Printing and Downloading Graphics

You can print graphics from the Graphic window or embedded in 
retrieved records. You can download graphics only from the Graphic 
window.

To print or download from the Graphic window:
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• Select Print Graphic or Download Graphic from the File menu at 
the Graphic window.

To print graphics embedded in records:

• Check Print Graphics in the Print Records Options dialog box. 
Graphics are printed within the text of records each time you print 
records.

See “Changing Print Options” on page 5–12 and “Changing Download 
Options” on page 5–15 for more information.

Marking and Unmarking Records

With WinSPIRS, you can easily mark the records in which you are 
interested, and later show, print, or download only those records. At any 
point, you can unmark records in which you are no longer interested.

You can mark records in the Search, Index, Table of Contents, and 
Hotlink screens

Records that provide the full text of documents are usually divided into 
sections and paragraphs that you can mark individually. Collectively, the 
reference fields of a full text record are treated as a section, except they 
do not have a page icon.

Marking Records The following table shows how to mark records for records.

To do this: Do this:

To mark a record Method 1:
Click the book icon to the left of the record you want to mark.

Method 2:
1. Put the cursor in the record.
2. Select Mark Record from the Mark menu.

WinSPIRS highlights the record. 

 (Sheet 1 of 2)
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To mark a section of a record Method 1:
Click the page icon to the left of the section that you want to 
mark; WinSPIRS highlights the text. 

Method 2:
1. Put the cursor in the section.
2. Select Mark Section from the Mark menu.

To mark a paragraph of a 
record

Method 1:
Click the torn page icon to the left of any paragraph you want 
to mark.

Method 2:
1. Put the cursor in the paragraph.
2. Select Mark Paragraph from the Mark menu.

To mark the reference fields 1. Put the cursor in any of the reference fields.
2. Select Mark Reference Fields from the Mark menu.

To unmark a record, section, 
or paragraph:

Method 1:
Click the book, page, or torn page icon to the left of the record 
or portion of record that you want to unmark. 

Method 2:
Select Unmark Record, Unmark Section, Unmark 
Paragraph, or Unmark Reference Fields from the Mark 
menu.

To unmark all marked text Select Unmark All from the Mark menu.

To do this: Do this:
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Printing Records

With WinSPIRS, you can print the records retrieved by any of your 
searches. You can also determine which fields are printed and whether 
graphics and the search history are included.

To print records:

1. Click Print on the button bar, or select Print Records from the File 
menu in the Search, Index, Table of Contents, or Hotlink screen. 
WinSPIRS displays the Print Records dialog box, as shown below

FIGURE 5-7 Print Records dialog box

2. Indicate the records you want to print in the Print Range area:

• Marked Records prints all records that are partially or fully 
marked.

• All Displayed Records prints all records displayed from the 
current search.

• Current Record prints the current retrieved record.

• Records lets you specify individual records to print. Separate 
record numbers with commas, and use a hyphen to indicate a 
range, such as 1,4,6-10.

3. Indicate which fields you want to print:

• As Shown prints the currently displayed fields.
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• Default prints the default fields for the database(s) you are 
searching.

• User Selected prints the fields selected in the Print Records 
Options (click Options... to view or change the selected fields).

• Marked and Default prints the default set of fields and any 
additional text that you have marked.

4. If desired, click Setup... to change the printer configuration.

5. Click Print to begin printing.

Changing Print 
Options

You can determine how records are printed by changing the Print 
Records Options. These options include which fields are printed, how 
field labels are printed, and whether graphics and the Search History are 
printed.

To change print options:

1. Choose Print Options... from the Options menu or click Options... 
in the Print Records dialog box. WinSPIRS displays the Print 
Records Options dialog box.

FIGURE 5-8 The Print Records Options dialog box

2. Add the fields you want to print to the Print these Fields list.
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Note: If the Make Default Fields button is available, you can make 
the selected set of fields the print default for the current database. 
You will be asked to restart WinSPIRS; the new default will be ef-
fective every time you search the current database.

3. Indicate how you want fields to print in the Field Labels area:

• Short Field Names prints field abbreviations, such as “TI”.

• Long Field Names prints full field names, such as “Title”.

• No Field Names omits field names from printed records.

4. Choose from the Other Options:

• Check Print Search History to include your search history with 
printed records.

• Check Indent Text to indent the text of retrieved records under 
the field labels.

• Check One Record Per Page to start each printed record on a 
new page.

• Check Print Graphics to print any graphics in the retrieved 
records. Each graphic is printed with its title, caption, and 
associated record number, if available.

5. Click OK to close the dialog box. The next time you print retrieved 
records, the new options will be in effect.

Note: To print a graphic by itself, you must first display the graphic in 
the Graphic window. Refer to “Displaying Graphics” on page 5–7 for 
more information.

Downloading Records

With WinSPIRS, you can download to a floppy or hard disk the records 
retrieved by any of your searches. You can also determine which fields 
are downloaded and whether graphics and the search history are 
included.

To download records:

1. Click Download on the button bar, or select Download Records 
from the File menu in the Search, Index, Table of Contents, or 
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Hotlink screen. WinSPIRS displays the Download Records dialog 
box.

FIGURE 5-9 Download Records dialog box

2. Type a name for the download file in the File Name box.

3. If necessary, choose a different drive and directory in which to save 
the file.

4. Check the type of records you want to download in the Download 
Range area:

• Marked Records downloads all records that are partially or 
fully marked.

• All Displayed Records downloads all records displayed from 
the current search.

• Current Record downloads the current retrieved record.

• Records lets you specify individual records to download. 
Separate record numbers with commas, and use a hyphen to 
indicate a range, such as 1,4,6-10.

5. Check the fields you want to download:

• As Shown downloads the currently displayed fields.

• Default downloads the default fields for the database(s) you are 
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searching.

• User Selected downloads the fields selected in the Download 
Records Options (click Options... to view or change the 
selected fields).

• Marked and Default downloads the default set of fields and any 
additional text you have marked.

6. Click Download to begin downloading.

Changing Download 
Options

You can determine how records are downloaded by changing the 
Download Records Options. These options include which fields are 
downloaded, how field labels are downloaded, and whether the Search 
History is downloaded.

To change download options:

1. Choose Download Options... from the Options menu or click 
Options... in the Download Records dialog box. WinSPIRS displays 
the Download Records Options dialog box.

FIGURE 5-10 Download Records Options dialog box

2. Add the fields you want to download to the Download these Fields 
list.
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Note: If the Make Default Fields button is available, you can make 
the selected set of fields the download default for the current data-
base. You will be asked to restart WinSPIRS; the new default will 
be effective every time you search the current database.

3. Indicate how you want fields to download in the Field Labels area:

• Short Field Names downloads field abbreviations, such as 
“TI”.

• Long Field Names downloads full field names, such as “Title”.

• No Field Names omits field names from downloaded records.

4. Choose from the Other Options:

• Check Download Search History to include your search 
history with downloaded records.

• Check Download Record Numbers to include record numbers, 
such as 1 of 7, with the downloaded records.

• Check Formatted ASCII Text to insert a carriage return/line 
feed after approximately 72 characters on each line.

5. Click OK to close the dialog box. The next time you download 
retrieved records, the new options will be in effect.

Note: To download graphics, you must first display the graphics in the 
Graphic window. Refer to “Displaying Graphics” on page 5–7 for more 
information.
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This chapter provides a brief definition for each button and menu item in 
WinSPIRS. For more information, refer to the Index or to the online 
Help.

Use this button/command On this screen/menu To do this

Add to List... Button on Thesaurus screen Add the current thesaurus term to a list of 
terms to search

Add to Search Button on Search/Index/Table 
of Contents screens

Add a highlighted term or phrase to the 
Search: text entry area on the Search 
screen

All Fields Button on Search/Index/Table 
of Contents screens

Display all fields in the retrieved records. 
It also expands the Retrieved Records 
area if Auto Full Screen is on in the 
Retrieved Records Options.

When you click All Fields, the button 
changes to Brief Fields.

Automatic Records 
Display

Search/Index/Thesaurus/ 
Table of Contents screens
> Options menu 

Determine whether retrieved records are 
displayed after each search.Turn 
Automatic Records Display off for faster 
searching; retrieved records are only 
displayed when you click Show in the 
Retrieved Records area.
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Back Hotlink window > Options 
menu 

Hotlink window and 
Thesaurus screen
Back button

At the Hotlink window, Back display the 
previous hotlinked record that you viewed.

At the Thesaurus screen, Back display 
the previous term information or permuted 
index that you viewed.

Brief Fields Search/Index/Table of 
Contents screens

Display the current set of fields selected in 
the Retrieved Records Options dialog 
box. It also shrinks the Retrieved Records 
area if Auto Full Screen is on in the 
Retrieved Records Options.

When you click Brief Fields, the button 
changes to All Fields.

Change... Index screen Display a list of available indexes from 
which you can choose a different index to 
search.

Change Index... Index screen > Options menu Display a list of available indexes from 
which you can choose a different index to 
search

Clear... Search screen > Search 
History area

Erase one or more searches from the 
current search history

Clear Search Area Search/ Index/Thesaurus 
screens > Edit menu

Erase all text from the text entry area of 
the active screen. 

Clear Search History... Search screen > Edit menu Erase all or a portion of your current 
search history.

Clear Term List Thesaurus screen > Edit 
menu

Delete all terms you added to the Selected 
Term List for later searching.

Clear Thesaurus History Thesaurus screen > Edit 
menu

Clear the Thesaurus History, which lists 
all the terms you viewed while in the 
Thesaurus 

To view the Thesaurus History, select 
Show Thesaurus History from the 
Options menu.

Use this button/command On this screen/menu To do this
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Close Graphic/Hotlink/Full Text 
windows

Close the active window

If you leave the window open, you can 
display it again by selecting Graphic 
Window or Hotlink Window from the 
Views menu.

Colours... Search/ Index/Thesaurus/ 
Table of Contents screens > 
Options menu 

Change the color scheme of the 
WinSPIRS display

Contents Button bar Display the Table of Contents screen for 
full-text databases. The button is grayed 
out if you are not searching a full-text 
database.

Contract Table of Contents screen Contract the highlighted Table of 
Contents topic

Contract All Table of Contents screen Contract all expanded Table of Contents 
topics

Copy Edit menu Copy the highlighted text or graphic to the 
Clipboard for later pasting.

Database Button bar Displays a list of available databases from 
which you can select one or more to 
search

Download Button bar

Button on Download Records 
dialog box

Download retrieved records to a floppy or 
hard disk

Download Graphic... Graphic window > File menu Save the currently displayed graphic to a 
floppy or hard disk.

Note: Even if graphics are displayed in 
the body of the record, they must be 
downloaded separately.

Download Options... Search/ Index/Table of 
Contents/Hotlink screens > 
Options menu

Determine which fields are downloaded 
and whether the Search History is 
included.

Use this button/command On this screen/menu To do this
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Download Records... Search/Index/Table of 
Contents/Hotlink screens > 
File menu 

Save the results of your current search to 
a floppy or hard disk. 

End of Record Search/ Index/ Table of 
Contents/Hotlink screens > 
Records menu

Move to the end of the current record.

Exit File menu. Exit WinSPIRS

Expand Table of Contents screen Expand the highlighted Table of Contents 
topic.

Explode Button on Thesaurus screen Search for an item, and any of its narrower 
terms.

Fields to Search... Search screen > Utilities menu Display a list of searchable fields in the 
database(s) you are searching

Fit to Window Graphic window > View menu Resize the displayed graphic to fit in the 
window. It is useful if you have changed 
the magnification of a graphic or if you 
have resized the window

Graphic Window Views menu Bring the open Graphic window to the 
foreground. (Only available if the Graphic 
window is open.)

Guide Help menu Provide unique and specific information 
about the database(s) you are using

Help Provide information about using the 
WinSPIRS software. Press [F1] or click 
the Help button to get Help on the active 
window or dialog box. You can also 
choose a Help topic from the Help menu.

Hotlink Window Search/ Index/ 
Thesaurus/Table of Contents 
screens > Views menu

Bring the open Hotlink window to the 
foreground. (Only available if the Hotlink 
window is open.)

Use this button/command On this screen/menu To do this
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Index Search/ Thesaurus/Table of 
Contents screens >Views 
menu

Index button appears on the 
Button bar

Open the Index screen.

Index Full Screen Index screen >Views Expand the Index area

Language Options... Search/ Index/ 
Thesaurus/Table of Contents 
screens > Options Menu

Select the language in which WinSPIRS 
displays screens, buttons, and menu 
items.

Limit... Search screen > Search 
History area

Limit the current search by language, 
publication year, or other limit field

Load and Run Searches...  Search screen > File menu Reuse a previously saved search history.

Look Up Index/Thesaurus screens Look in the Index Terms or Permuted 
Index for the term you typed, and scrolls to 
the nearest match.

Make Default Fields Download Records Options/ 
Print Records 
Options/Retrieved Records 
Options dialog boxes.

Button

Make the selected fields the default for 
downloading, printing, or showing records 
with the current database. WinSPIRS 
needs to restart to change the default 
fields.

The Make Default Fields button is 
unavailable if WinSPIRS is not configured 
to allow setting of default fields.

Mark Paragraph Search/ Index/Table of 
Contents/ Hotlink screens > 
Mark menu

Mark the current paragraph of a full-text 
record.

Mark Record Search/ Index/Table of 
Contents/Hotlink screens > 
Mark menu

Mark the current record for later printing or 
downloading

Mark Reference Fields Search/ Index/Table of 
Contents/Hotlink screens > 
Mark menu

Mark the bibliographic fields of a full-text 
record.

Use this button/command On this screen/menu To do this

 (Sheet 5 of 10)



6–6  WinSPIRS Commands
Mark Section Search/ Index/Table of 
Contents/Hotlink screens > 
Mark menu

Mark the current section of a full-text 
record.

Next Hit  Search/Index/Table of 
Contents/Hotlink screens > 
Records menu 

Next Hit button is available at 
the bottom of those screens.

Move to the next occurrence of the term 
you searched.

Next Record Search/ Index,/Table of 
Contents screens > Records 
menu

Move to the record immediately following 
the current record

Paste Search/ Index/Thesaurus/ 
Table of Contents screens > 
Edit menu

 Insert the contents of the Clipboard at the 
insertion point. Paste is only available if 
you have copied text from WinSPIRS or 
another application to the Clipboard. 

Previous Hit Search/Index/Table of 
Contents/Hotlink screens > 
Records menu

Previous Hit button is 
available at the bottom of 
those screens.

Move to the previous occurrence of the 
term you searched.

Previous Record Search/ Index/Table of 
Contents screens > Records 
menu

Move to the record immediately preceding 
the current record

Print Button bar Print retrieved records.

Print Graphic... Graphic window > File menu Print the displayed graphic.

Print Options... Search/Index/Hotlink screens 
> Options menu

Button on Print Records dialog 
box

Determine which fields are printed, how 
field names are printed, and whether 
graphics and the search history are 
included. 

Print Records...  Search/Index/Table of 
Contents/Hotlink screens > 
File menu

Print retrieved records

Use this button/command On this screen/menu To do this
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Print Setup... Search/Index/Table of 
Contents/Hotlink/Graphic 
screens > File menu 

Button on Print Records dialog 
box

Select which printer to use, page 
orientation, and paper size. See your 
Windows documentation for details on 
Print Setup options

Records Full Screen Search/ Index/ Table of 
Contents screens > Views 
menu

Expand the Retrieved Records area.

Reset Thesaurus Thesaurus screen > Options 
menu

Choose Reset Thesaurus to clear the 
term list and Thesaurus history and return 
the Thesaurus to its startup condition

Restart... Search/ Index/Table of 
Contents/Thesaurus screens 
> File menu 

 Reset all options to their defaults, clear 
the Search History, and restart WinSPIRS

Retype Search screen > Search 
History area

Re-enter the text of the highlighted search 
in the Search: text entry area,

Edit the statement and search again 
without retyping the entire statement.

Save Search History... Search screen > File menu Save your search history to a floppy or 
hard disk for later use.

Search Button on Search/Index 
screens

On the Search screen, it searches for the 
term you typed in the Search: text entry 
area. On the Index screen, it copies the 
highlighted index term to the Search 
screen and searches for the term.

Search History Full 
Screen

 Search screen > Views menu Expand the Search History area

Search List Button on the Thesaurus 
screen.

Search for the Thesaurus terms you have 
added to the Term List

Search Now Button on the Thesaurus 
screen.

Copy the highlighted thesaurus term to 
the Search screen and searches for the 
term. (Depending on the database, you 
may be prompted to add one or more 
subheadings to the term before 
searching.)

Use this button/command On this screen/menu To do this
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Search Options Radio buttons on Thesaurus 
screen

Select one of the following, then click 
Search Now

Single Term: to search only for that term.

Explode: to search for that term, and any 
narrower terms.

Searches  Search/ 
Index/Thesaurus/Table of 
Contents screens > Views 
menu

Searches button appears on 
the button bar.

Move to the Search screen

Select Database... Search screen > File menu Display a list of available databases from 
which you can select one or more to 
search.

Show Search/Index/Table of 
Contents screens

Display the record(s) associated with the 
highlighted search statement, index term, 
or contents heading.

Show Held Titles Only Search/Index/Table of 
Contents screens > Records 
menu

Display only records from documents held 
at your library. It is only available if your 
system administrator has set up a library 
holdings file.

Show Hits Per Database  Search screen > Options 
menu

Indicate the number of records your 
searches retrieve from each database, if 
you are searching more than one

Show Intermediate 
Results

 Search screen > Options 
menu

Display the results of each word when you 
search for a phrase, rather than just the 
results of the phrase.

Show Marked Records Search/Index screens > 
Records menu

Show only the retrieved records you have 
marked.

Show Options...  Search/Index/Table of 
Contents/Hotlink screens > 
Options menu

Determine which fields are displayed, how 
field names are displayed, and whether 
graphics are displayed.

Show Thesaurus History Thesaurus screen > Options 
menu

Display a list of the thesaurus terms you 
have viewed.

Use this button/command On this screen/menu To do this
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Sort Records...  Search/Index screens > 
Records menu

Sort retrieved records and specify the field 
to sort on and the order in which to sort

Split Screen  Search/Index,/ Table of 
Contents screens > Views 
menu

Divide the screen between the Retrieved 
Records area and the Search History, 
Index Terms, or Table of Contents area

Start of Record  Search/ Index/Table of 
Contents, and Hotlink screens 
> Records menu

Move you to the beginning of the current 
record

Suggest Button on Search screen. Provide alternate search terms for the 
term you enter

Synchronize Table of Contents screen Display the portion of the Table of 
Contents that corresponds to the text 
currently displayed in the Retrieved 
Records area

Table of Contents Search screen/ Index screen 
/Thesaurus screen >Views 
menu

Display the Table of Contents screen for 
full-text databases Note: The Table of 
Contents command is disabled in 
bibliographic databases

Table of Contents Full 
Screen

 Table of Contents screen 
>Views menu

Expand the Table of Contents area

Term Information Thesaurus screen. Display details about a highlighted term, 
such as definitions, scope notes, and 
broader and narrower terms.

Thesaurus Search/Index/Table of 
Contents screens > Views 
menu

Thesaurus button appears on 
the button bar.

Display the database’s online Thesaurus

Undo Last Move  Search/Index/Table of 
Contents/Hotlink screens > 
Records menu

Cancel the last action you performed

Unmark All Search/Index/Table of 
Contents/Hotlink screens > 
Mark menu

Unmark all marked records

Use this button/command On this screen/menu To do this
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Unmark Paragraph Search/ Index/Table of 
Contents/Hotlink screens > 
Mark menu

Unmark the current paragraph of the full-
text record

Unmark Record Search/Index/Table of 
Contents/Hotlink screens > 
Mark menu

Unmark the current record

Unmark Reference Fields Search/Index/Table of 
Contents/Hotlink screens > 
Mark menu

Unmark the bibliographic fields of the 
current full-text record

Unmark Section Search/Index/Table of 
Contents/Hotlink screen > 
Mark menu

Unmark the current section of the full-text 
record.

View Full Tree Thesaurus screen > Options 
menu

Display all the broader and narrower 
terms of the current term. This is not 
available for all thesauri.

View Last Suggestions... Search screen >Utilities menu Display the list of alternate search terms 
from the last time you clicked Suggest.

View List... Button on the Thesaurus 
screen

Display the list of Thesaurus terms you 
have selected for searching

View Loaded Databases... Search/Index/Thesaurus/ 
Table of Contents screens 
>Utilities menu.

List the currently loaded databases. 

Zoom In Graphic window >View menu

Zoom In button is available at 
the top of the Graphic window.

Enlarge the current graphic

Zoom Out Graphic window >View menu

Zoom Out button is available 
at the top of the Graphic 
window

Shrink the current graphic

Use this button/command On this screen/menu To do this
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restarting WinSPIRS 3-12, 6-7
Retype button 6-7
reusing search requests 4-4, 4-24
running saved searches 4-26

S
saving

search histories 4-26, 6-7
see also downloading

search history
clearing searches from 4-25, 6-2
downloading 5-16
printing 5-13
reusing searches 4-24
saving 4-26, 6-7

Load and Run Searches 4-26, 6-
5

Search History Full Screen 6-7
Show Hits Per Database 6-8
Show Intermediate Results 6-8

searching
combining terms 4-6–4-8
examples 4-2–4-3
fields 4-4, 4-9–4-11
finding word variants 4-3, 4-4
from retrieved records 5-4
hyphenated phrases 4-3, 4-4
limit fields 4-10–4-11
multiple databases 4-27, 4-28
narrowing and broadening your 

search 4-28
numbers 4-3
operators 4-4, 4-6–4-8
options 2-5
parentheses 4-4, 4-5
quotes 4-3
reusing previous searches 4-4
Search screen, overview 3-6, 4-2
semi-colons 4-4
stopwords 4-13

suggested terms 4-11, 6-9, 6-10
truncation and wildcards 4-3, 4-4, 4-

28
see also Index; search history; Table 

of Contents; Thesaurus
selecting

databases 3-2–3-3
Index terms 4-14
indexes 4-15
terms from records 5-4
Thesaurus terms 4-19, 6-1
see also changing; marking

semi-colons 4-4
showing

All Fields 6-1
Automatic Records Display 4-3, 5-1, 

6-1
fonts 5-3
graphics 5-2, 5-7–5-9
Make Default Fields 5-2, 6-5
marked records 6-8
options 5-1, 6-8
records 6-8

in Hotlink window 5-4
in Index 4-13
in Search screen 4-3, 5-1
in sorted order 5-3
in Table of Contents 4-23

Show Held Titles Only 6-8
Show Hits Per Database 6-8
Show Intermediate Results 4-3, 6-8
Split Screen 6-9
Thesaurus history 6-8
trees in Thesaurus 4-18
see also viewing

SilverLinker
configuring 2-6
displaying links 5-6

SilverPlatter Information 1-2
software requirements 2-2
sorting records 5-3, 6-9
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SPLHA. see library holdings
Split Screen 6-9
Start of Record 6-9
starting WinSPIRS 3-1
stopwords 4-13
subheadings 4-20
suggested terms 6-9

exploding 4-12
searching for 4-11
View Last Suggestions 6-10

Synchronize button 4-24, 6-9
synonyms. see Thesaurus

T
Table of Contents

expanding topics 6-4
overview 3-10
searching 4-23–4-24
showing records 4-23
Synchronize button 4-24, 6-9
Table of Contents Full Screen 6-9

tables. see Fixed Font
Term Information 4-17, 6-9
Thesaurus

overview 3-9
Permuted Index 4-16
resetting 6-7
searching 4-15–4-22, 4-28, 6-7
selecting terms 4-19, 6-1
subheadings 4-20
Term Information 4-17, 6-9
Thesaurus history

showing 4-21, 6-8
trees 4-18
View Full Tree 4-18, 6-10
View List 4-19, 6-10

title screen 3-3
trees 4-18
truncation 4-3, 4-4, 4-28

U
Undo Last Move 6-9

unmarking records 5-9, 6-9, 6-10

V
valid search requests 4-3
verLinker 5-6
viewing

tables. see Fixed Font
View Full Tree 4-18, 6-10
View Last Suggestions 6-10
View List 6-10
View Loaded Databases 6-10
see also showing

W
wildcards 4-4, 4-28
WinSPIRS

button bar 3-4
configuring 2-4
exiting 3-12, 6-4
Help 3-11–3-12, 6-4
installing 2-2
languages 6-5
menu bar 3-4–3-6
restarting 3-12, 6-7
starting 3-1
winspirs.ini 2-6

WITH operator 4-6, 4-28
workstation options 2-5

Z
zooming in and out of graphics 5-8, 6-10
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